
TUTORIAL MANUAL

1 SETTLEMENT OF A CIRCULAR FOOTING ON SAND

In this chapter a first application is considered, namely the settlement of a circular
foundation footing on sand. This is the first step in becoming familiar with the practical
use of PLAXIS 2D. The general procedures for the creation of a geometry model, the
generation of a finite element mesh, the execution of a finite element calculation and the
evaluation of the output results are described here in detail. The information provided in
this chapter will be utilised in the later tutorials. Therefore, it is important to complete this
first tutorial before attempting any further tutorial examples.

Objectives:

• Starting a new project.

• Creating an axisymmetric model

• Creating soil stratigraphy using the Borehole feature.

• Creating and assigning of material data sets for soil (Mohr-Coulomb model).

• Defining prescribed displacements.

• Creation of footing using the Plate feature.

• Creating and assigning material data sets for plates.

• Creating loads.

• Generating the mesh.

• Generating initial stresses using the K0 procedure.

• Defining a Plastic calculation.

• Activating and modifying the values of loads in calculation phases.

• Viewing the calculation results.

• Selecting points for curves.

• Creating a 'Load - displacement' curve.

1.1 GEOMETRY

A circular footing with a radius of 1.0 m is placed on a sand layer of 4.0 m thickness as
shown in Figure 1.1. Under the sand layer there is a stiff rock layer that extends to a large
depth. The purpose of the exercise is to find the displacements and stresses in the soil
caused by the load applied to the footing. Calculations are performed for both rigid and
flexible footings. The geometry of the finite element model for these two situations is
similar. The rock layer is not included in the model; instead, an appropriate boundary
condition is applied at the bottom of the sand layer. To enable any possible mechanism in
the sand and to avoid any influence of the outer boundary, the model is extended in
horizontal direction to a total radius of 5.0 m.
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Figure 1.1 Geometry of a circular footing on a sand layer

1.2 CASE A: RIGID FOOTING

In the first calculation, the footing is considered to be very stiff and rough. In this
calculation the settlement of the footing is simulated by means of a uniform indentation at
the top of the sand layer instead of modelling the footing itself. This approach leads to a
very simple model and is therefore used as a first exercise, but it also has some
disadvantages. For example, it does not give any information about the structural forces
in the footing. The second part of this tutorial deals with an external load on a flexible
footing, which is a more advanced modelling approach.

1.2.1 GEOMETRY INPUT

Start PLAXIS 2D by double clicking the icon of the Input program. The Quick select
dialog box appears in which you can create a new project or select an existing one
(Figure 1.2).

Figure 1.2 Quick select dialog box

• Click Start a new project. The Project properties window appears, consisting of
three tabsheets, Project, Model and Constants (Figure 1.3 and Figure 1.4).
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Project properties

The first step in every analysis is to set the basic parameters of the finite element model.
This is done in the Project properties window. These settings include the description of
the problem, the type of model, the basic type of elements, the basic units and the size of
the drawing area.

Figure 1.3 Project tabsheet of the Project properties window

To enter the appropriate settings for the footing calculation follow these steps:

• In the Project tabsheet, enter "Lesson 1" in the Title box and type "Settlement of a
circular footing" in the Comments box.

• Click the Next button below the tabsheets or click the Model tab.

• In the Type group the type of the model (Model) and the basic element type
(Elements) are specified. Since this tutorial concerns a circular footing, select the
Axisymmetry and the 15-Noded options from the Model and the Elements
drop-down menus respectively.

• In the Contour group set the model dimensions to xmin = 0.0, xmax = 5.0, ymin = 0.0
and ymax = 4.0.

• Keep the default units in the Constants tabsheet.

Figure 1.4 Model tabsheet of the Project properties window
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• Click OK button to confirm the settings.

Hint: In the case of a mistake or for any other reason that the project properties
need to be changed, you can access the Project properties window by
selecting the corresponding option from the File menu.

Definition of soil stratigraphy

When you click the OK button the Project properties window will close and the Soil mode
view will be shown where the soil stratigraphy can be defined.

Hint: The modelling process is completed in five modes. More information on
modes is available in the Section 3.5 of the Reference Manual.

Information on the soil layers is entered in boreholes. Boreholes are locations in the
drawing area at which the information on the position of soil layers and the water table is
given. If multiple boreholes are defined, PLAXIS 2D will automatically interpolate
between the boreholes. The layer distribution beyond the boreholes is kept horizontal. In
order to construct the soil stratigraphy follow these steps:

Click the Create borehole button in the side (vertical) toolbar to start defining the soil
stratigraphy.

• Click at x = 0 in the drawing area to locate the borehole. The Modify soil layers
window will appear.

• In the Modify soil layers window add a soil layer by clicking the Add button.

• Set the top boundary of the soil layer at y = 4 and keep the bottom boundary at y = 0
m.

• By default the Head value (groundwater head) in the borehole column is set to 0 m.
Set the Head to 2.0 m (Figure 1.5).

The creation of material data sets and their assignment to soil layers is described in the
following section.

Material data sets

In order to simulate the behaviour of the soil, a suitable soil model and appropriate
material parameters must be assigned to the geometry. In PLAXIS 2D, soil properties are
collected in material data sets and the various data sets are stored in a material
database. From the database, a data set can be assigned to one or more soil layers. For
structures (like walls, plates, anchors, geogrids, etc.) the system is similar, but different
types of structures have different parameters and therefore different types of material
data sets. PLAXIS 2D distinguishes between material data sets for Soil and interfaces,
Plates, Geogrids, Embedded beam rows and Anchors.
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Figure 1.5 Modify soil layers window

To create a material set for the sand layer, follow these steps:

Open the Material sets window by clicking the Materials button in the Modify soil
layers window. The Material sets window pops up (Figure 1.6).

Figure 1.6 Material sets window

• Click the New button at the lower side of the Material sets window. A new window
will appear with six tabsheets: General, Parameters, Groundwater, Thermal,
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Interfaces and Initial.

• In the Material set box of the General tabsheet, write "Sand" in the Identification box.

• The default material model (Mohr-Coulomb) and drainage type (Drained) are valid
for this example.

• Enter the proper values in the General properties box (Figure 1.7) according to the
material properties listed in Table 1.1. Keep parameters that are not mentioned in
the table at their default values.

Figure 1.7 The General tabsheet of the Soil window of the Soil and interfaces set type

• Click the Next button or click the Parameters tab to proceed with the input of model
parameters. The parameters appearing on the Parameters tabsheet depend on the
selected material model (in this case the Mohr-Coulomb model).

• Enter the model parameters of Table 1.1 in the corresponding edit boxes of the
Parameters tabsheet (Figure 1.8). A detailed description of different soil models and
their corresponding parameters can be found in the Material Models Manual.

Hint: To understand why a particular soil model has been chosen, see Appendix B
of the Material Models Manual.

• The soil material is drained, the geometry model does not include interfaces and the
default thermal and initial conditions are valid for this case, therefore the remaining
tabsheets can be skipped. Click OK to confirm the input of the current material data
set. Now the created data set will appear in the tree view of the Material sets
window.

• Drag the set Sand from the Material sets window (select it and hold down the left
mouse button while moving) to the graph of the soil column on the left hand side of
the Modify soil layers window and drop it there (release the left mouse button).

• Click OK in the Material sets window to close the database.

• Click OK to close the Modify soil layers window.
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Figure 1.8 The Parameters tabsheet of the Soil window of the Soil and interfaces set type

Table 1.1 Material properties of the sand layer

Parameter Name Value Unit

General

Material model Model Mohr-Coulomb -

Type of material behaviour Type Drained -

Soil unit weight above phreatic level γunsat 17.0 kN/m3

Soil unit weight below phreatic level γsat 20.0 kN/m3

Parameters

Young's modulus (constant) E ' 1.3 · 104 kN/m2

Poisson's ratio ν ' 0.3 -

Cohesion (constant) c'ref 1.0 kN/m2

Friction angle ϕ' 30.0 ◦

Dilatancy angle ψ 0.0 ◦

Visibility of a grid in the drawing area can simplify the definition of geometry. The grid
provides a matrix on the screen that can be used as reference. It may also be used for
snapping to regular points during the creation of the geometry. The grid can be activated
by clicking the corresponding button under the drawing area. To define the size of the
grid cell and the snapping options:

Click the Snapping options button in the bottom toolbar. The Snapping window pops
up where the size of the grid cells and the snapping interval can be specified. The
spacing of snapping points can be further divided into smaller intervals by the
Number of snap intervals value. Use the default values in this example.

Definition of structural elements

The structural elements are created in the Structures mode of the program where a
uniform indentation will be created to model a very stiff and rough footing.

• Click the Structures tab to proceed with the input of structural elements in the
Structures mode.
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Hint: Existing data sets may be changed by opening the Material sets window,
selecting the data set to be changed from the tree view and clicking the Edit
button. As an alternative, the Material sets window can be opened by clicking
the corresponding button in the side toolbar.

» PLAXIS 2D distinguishes between a project database and a global database
of material sets. Data sets may be exchanged from one project to another
using the global database. The global database can be shown in the Material
sets window by clicking the Show global button. The data sets of all tutorials
in the Tutorial Manual are stored in the global database during the installation
of the program.

» The material assigned to a selected entity in the model can be changed in
the Material drop-down menu in the Selection explorer. Note that all the
material datasets assignable to the entity are listed in the drop-down menu.
However, only the materials listed under Project materials are listed, and not
the ones listed under Global materials.

» The program performs a consistency check on the material parameters and
will give a warning message in the case of a detected inconsistency in the
data.

Click the Create prescribed displacement button in the side toolbar.

Select the Create line displacement option in the expanded menu (Figure 1.9).

Figure 1.9 The Create line displacement option in the Prescribed displacement menu

• In the drawing area move the cursor to point (0 4) and click the left mouse button

• Move along the upper boundary of the soil to point (1 4) and click the left mouse
button again.

• Click the right mouse button to stop drawing.

• In the Selection explorer set the x-component of the prescribed displacement
(Displacementx ) to Fixed.

• Specify a uniform prescribed displacement in the vertical direction by assigning a
value of -0.05 to uy ,start ,ref , signifying a downward displacement of 0.05 m (Figure
1.10).

The geometry of the model is complete.

Mesh generation

When the geometry model is complete, the finite element mesh can be generated.
PLAXIS 2D allows for a fully automatic mesh generation procedure, in which the
geometry is divided into elements of the basic element type and compatible structural
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Figure 1.10 Prescribed displacement in the Selection explorer

elements, if applicable.

The mesh generation takes full account of the position of points and lines in the model,
so that the exact position of layers, loads and structures is accounted for in the finite
element mesh. The generation process is based on a robust triangulation principle that
searches for optimised triangles. In addition to the mesh generation itself, a
transformation of input data (properties, boundary conditions, material sets, etc.) from the
geometry model (points, lines and clusters) to the finite element mesh (elements, nodes
and stress points) is made.

In order to generate the mesh, follow these steps:

• Proceed to the Mesh mode by clicking the corresponding tab.

Click the Generate mesh button in the side toolbar. The Mesh options window pops
up.

• The Medium option is by default selected as element distribution.

• Click OK to start the mesh generation.

Figure 1.11 The Mesh options window

As the mesh is generated, click the View mesh button. A new window is opened
displaying the generated mesh (Figure 1.12). Note that the mesh is automatically
refined under the footing.

Click on the Close tab to close the Output program and go back to the Mesh mode
of the Input program.
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Hint: By default, the Element distribution is set to Medium. The Element
distribution setting can be changed in the Mesh options window. In addition,
options are available to refine the mesh globally or locally (Section 7.1 of
Reference Manual).

» The finite element mesh has to be regenerated if the geometry is modified.
» The automatically generated mesh may not be perfectly suitable for the

intended calculation. Therefore it is recommended that the user inspects the
mesh and makes refinements if necessary.

Figure 1.12 The generated mesh in the Output window

1.2.2 PERFORMING CALCULATIONS

Once the mesh has been generated, the finite element model is complete.

Initial conditions

The 'Initial phase' always involves the generation of initial conditions. In general, the initial
conditions comprise the initial geometry configuration and the initial stress state, i.e.
effective stresses, pore pressures and state parameters, if applicable.

Click the Staged construction tab to proceed with the definition of calculation phases.
The Flow conditions mode may be skipped. When a new project has been defined, a first
calculation phase named "Initial phase", is automatically created and selected in the
Phases explorer (Figure 1.13). All structural elements and loads that are present in the
geometry are initially automatically switched off; only the soil volumes are initially active.

In this tutorial lesson the properties of the Initial phase will be described. Below an
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Figure 1.13 Phases explorer

overview is given of the options to be defined even though the default values of the
parameters are used.

The Phases window (Figure 1.14) is displayed by clicking the Edit phase button or
by double clicking on the phase in the Phases explorer.

Figure 1.14 The Phases window for Initial phase

By default the K0 procedure is selected as Calculation type in the General subtree
of the Phases window. This option will be used in this project to generate the initial
stresses.

The Staged construction option is available as Loading type.

The Phreatic option is selected by default as the Pore pressure calculation type.

The Ignore temperature option is selected by default as the Thermal calculation type.

• The other default options in the Phases window will be used as well in this tutorial.
Click OK to close the Phases window.

Hint: The K0 procedure should be primarily used for horizontally layered
geometries with a horizontal ground surface and, if applicable, a horizontal
phreatic level. See Section 7.3 of the Reference Manual for more information
on the K0 procedure.

For deformation problems two types of boundary conditions exist: Prescribed
displacement and prescribed forces (loads). In principle, all boundaries must have one
boundary condition in each direction. That is to say, when no explicit boundary condition
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is given to a certain boundary (a free boundary), the natural condition applies, which is a
prescribed force equal to zero and a free displacement.

To avoid the situation where the displacements of the geometry are undetermined, some
points of the geometry must have prescribed displacements. The simplest form of a
prescribed displacement is a fixity (zero displacement), but non-zero prescribed
displacements may also be given.

• In the Model explorer expand the Model conditions subtree.

• Expand the Deformations subtree. Note that the box is checked by default. By
default, a full fixity is generated at the base of the geometry, whereas roller supports
are assigned to the vertical boundaries (BoundaryXMin and BoundaryXMax are
normally fixed, BoundaryYMin is fully fixed and BoundaryYMax is free).

• Expand the Water subtree. The water level generated according to the Head value
assigned to boreholes in the Modify soil layers window (BoreholeWaterLevel_1) is
automatically assigned to GlobalWaterLevel (Figure 1.15).

Figure 1.15 The Deformations and Water subtrees in the Model explorer

The initial water level has been entered already in the Modify soil layers window.

• The water level defined according to the Head specified for boreholes is displayed
(Figure 1.16). Note that only the global water level is displayed in both Phase
definition modes. All the water levels are displayed in the model only in the Flow
conditions mode.

Phase 1: Footing

In order to simulate the settlement of the footing in this analysis, a plastic calculation is
required. PLAXIS 2D has a convenient procedure for automatic load stepping, which is
called 'Load advancement'. This procedure can be used for most practical applications.
Within the plastic calculation, the prescribed displacements are activated to simulate the
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Figure 1.16 Initial phase in the Staged construction mode

indentation of the footing. In order to define the calculation phase follow these steps:

Click the Add phase button in the Phases explorer. A new phase, named Phase_1
will be added in the Phases explorer.

• Double-click Phase_1 to open the Phases window.

• In the ID box of the General subtree, write (optionally) an appropriate name for the
new phase (for example "Indentation").

• The current phase starts from the Initial phase, which contains the initial stress
state. The default options and values assigned are valid for this phase (Figure 1.17).

Figure 1.17 The Phases window for the Indentation phase

• Click OK to close the Phases window.

• Click the Staged construction tab to enter the corresponding mode.

• Right-click the prescribed displacement in the drawing area and select the Activate
option in the appearing menu (Figure 1.18).

Hint: Calculation phases may be added, inserted or deleted using the Add, Insert
and Delete buttons in the Phases explorer or in the Phases window.
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Figure 1.18 Activation of the prescribed displacement in the Staged construction mode

Execution of calculation

All calculation phases (two phases in this case) are marked for calculation (indicated by a
blue arrow). The execution order is controlled by the Start from phase parameter.

Click the Calculate button to start the calculation process. Ignore the warning that
no nodes and stress points have been selected for curves. During the execution of a
calculation, a window appears which gives information about the progress of the
actual calculation phase (Figure 1.19).

Figure 1.19 Active task window displaying the calculation progress

The information, which is continuously updated, shows the calculation progress, the
current step number, the global error in the current iteration and the number of plastic
points in the current calculation step. It will take a few seconds to perform the calculation.
When a calculation ends, the window is closed and focus is returned to the main window.
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The phase list in the Phases explorer is updated. A successfully calculated phase is
indicated by a check mark inside a green circle.

Save the project before viewing results.

Viewing calculation results

Once the calculation has been completed, the results can be displayed in the Output
program. In the Output program, the displacement and stresses in the full two
dimensional model as well as in cross sections or structural elements can be viewed.
The computational results are also available in tabular form.

To check the applied load that results from the prescribed displacement of 0.05 m:

• Open the Phases window.

• For the current application the value of Force-Y in the Reached values subtree is
important. This value represents the total reaction force corresponding to the
applied prescribed vertical displacement, which corresponds to the total force under
1.0 radian of the footing (note that the analysis is axisymmetric). In order to obtain
the total footing force, the value of Force-Y should be multiplied by 2π (this gives a
value of about 588 kN).

The results can be evaluated in the Output program. In the Output window you can view
the displacements and stresses in the full geometry as well as in cross sections and in
structural elements, if applicable. The computational results are also available in
tabulated form. To view the results of the footing analysis, follow these steps:

• Select the last calculation phase in the Phases explorer.

Click the View calculation results button in the side toolbar. As a result, the Output
program is started, showing the deformed mesh at the end of the selected
calculation phase (Figure 1.20). The deformed mesh is scaled to ensure that the
deformations are visible.

• In the Deformations menu select the Total displacements→ |u| option. The plot
shows colour shadings of the total displacements. The colour distribution is
displayed in the legend at the right hand side of the plot.

Hint: The legend can be toggled on and off by clicking the corresponding option in
the View menu.

The total displacement distribution can be displayed in contours by clicking the
corresponding button in the toolbar. The plot shows contour lines of the total
displacements, which are labelled. An index is presented with the displacement
values corresponding to the labels.

Clicking the Arrows button, the plot shows the total displacements of all nodes as
arrows, with an indication of their relative magnitude.

• In the Stresses menu point to the Principal effective stresses and select the
Effective principal stresses option from the appearing menu. The plot shows the
effective principal stresses at the stress points of each soil element with an
indication of their direction and their relative magnitude (Figure 1.21).
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Figure 1.20 Deformed mesh

Hint: In addition to the total displacements, the Deformations menu allows for the
presentation of Incremental displacements. The incremental displacements
are the displacements that occurred within one calculation step (in this case
the final step). Incremental displacements may be helpful in visualising an
eventual failure mechanism.

» The plots of stresses and displacements may be combined with geometrical
features, as available in the Geometry menu.

Click the Table button on the toolbar. A new window is opened in which a table is
presented, showing the values of the principal stresses and other stress measures
in each stress point of all elements.
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Figure 1.21 Effective principal stresses

1.3 CASE B: FLEXIBLE FOOTING

The project is now modified so that the footing is modelled as a flexible plate. This
enables the calculation of structural forces in the footing. The geometry used in this
exercise is the same as the previous one, except that additional elements are used to
model the footing. The calculation itself is based on the application of load rather than
prescribed displacement. It is not necessary to create a new model; you can start from
the previous model, modify it and store it under a different name. To perform this, follow
these steps:

Modifying the geometry

• In the Input program select the Save project as option of the File menu. Enter a
non-existing name for the current project file and click the Save button.

• Go back to the Structures mode.

Right-click the prescribed displacement. In the right mouse button menu point to the
Line displacement option. In the expanded menu click on the Delete option (Figure
1.22).

• In the model right-click the line at the location of the footing. Point on Create and
select the Plate option in the appearing menu (Figure 1.23). A plate is created which
simulates the flexible footing.

• In the model right-click again the line at the location of the footing. Point on Create
and select the Line load option in the appearing menu (Figure 1.24).
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Figure 1.22 Delete Prescribed displacement

Figure 1.23 Assignment of Plate to line

Figure 1.24 Assignment of Line load to line

• In the Selection explorer the default input value of the distributed load is -1.0 kN/m2
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in the y-direction. The input value will later be changed to the real value when the
load is activated.

Adding material properties for the footing

Click the Materials button in the side toolbar.

• Select Plates from the Set type drop-down menu in the Material sets window.

• Click the New button. A new window appears where the properties of the footing
can be entered.

• Write "Footing" in the Identification box. The Elastic option is selected by default for
the material type. Keep this option for this example.

• Enter the properties as listed in Table 1.2. Keep parameters that are not mentioned
in the table at their default values.

• Click OK. The new data set now appears in the tree view of the Material sets
window.

Hint: The equivalent thickness is automatically calculated by PLAXIS from the
values of EA and EI. It cannot be defined manually.

Table 1.2 Material properties of the footing

Parameter Name Value Unit

Material type Type Elastic; Isotropic -

Normal stiffness EA 5 · 106 kN/m

Flexural rigidity EI 8.5 · 103 kNm2/m

Weight w 0.0 kN/m/m

Poisson's ratio ν 0.0 -

• Drag the set "Footing" to the drawing area and drop it on the footing. Note that the
shape of the cursor changes to indicate that it is valid to drop the material set.

Hint: If the Material sets window is displayed over the footing and hides it, click on
its header and drag it to another position.

• Close the database by clicking the OK button.

Generating the mesh

• Proceed to the Mesh mode.

Create the mesh. Use the default option for the Element distribution parameter
(Medium).

View the mesh.

• Click on the Close tab to close the Output program.
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Hint: Regeneration of the mesh results in a redistribution of nodes and stress
points.

Calculations

• Proceed to the Staged construction mode.

• The initial phase is the same as in the previous case.

• Double-click the following phase (Phase_1) and enter an appropriate name for the
phase ID. Keep Plastic as Calculation type and keep Staged construction as loading
type.

• Close the Phases window.

• In the Staged construction mode activate the load and plate. The model is shown in
Figure 1.25.

Figure 1.25 Active plate and load in the model

• In the Selection explorer assign −188 kN/m2 to the vertical component of the line
load (Figure 1.26). Note that this gives a total load that is approximately equal to the
footing force that was obtained from the first part of this tutorial. (188 kN/m2 · π·(1.0
m)2 ≈ 590 kN).

• No changes are required in the Flow conditions tabsheet.

The calculation definition is now complete. Before starting the calculation it is advisable
to select nodes or stress points for a later generation of load-displacement curves or
stress and strain diagrams. To do this, follow these steps:

Click the Select points for curves button in the side toolbar. As a result, all the nodes
and stress points are displayed in the model in the Output program. The points can
be selected either by directly clicking on them or by using the options available in the
Select points window.

• In the Select points window enter (0.0 4.0) for the coordinates of the point of interest
and click Search closest. The nodes and stress points located near that specific
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Figure 1.26 Definition of the load components in the Selection explorer

location are listed.

• Select the node at exactly (0.0 4.0) by checking the box in front of it. The selected
node is indicated by Node 4∗ in the model when the Selection labels option is
selected in the Mesh menu.

Hint: Instead of selecting nodes or stress points for curves before starting the
calculation, points can also be selected after the calculation when viewing
the output results. However, the curves will be less accurate since only the
results of the saved calculation steps will be considered.
To select the desired nodes by clicking on them, it may be convenient to use
the Zoom in option on the toolbar to zoom into the area of interest.

• Click the Update button to return to the Input program.

• Check if both calculation phases are marked for calculation by a blue arrow. If this is
not the case click the symbol of the calculation phase or right-click and select Mark
for calculation from the pop-up menu.

Click the Calculate button to start the calculation.

Save the project after the calculation has finished.

Viewing the results

After the calculation the results of the final calculation step can be viewed by clicking
the View calculation results button. Select the plots that are of interest. The
displacements and stresses should be similar to those obtained from the first part of
the exercise.

Click the Select structures button in the side toolbar and double click the footing. A
new window opens in which either the displacements or the bending moments of the
footing may be plotted (depending on the type of plot in the first window).

• Note that the menu has changed. Select the various options from the Forces menu
to view the forces in the footing.
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Hint: Multiple (sub-)windows may be opened at the same time in the Output
program. All windows appear in the list of the Window menu. PLAXIS follows
the Windows standard for the presentation of sub-windows (Cascade, Tile,
Minimize, Maximize, etc).

Generating a load-displacement curve

In addition to the results of the final calculation step it is often useful to view a
load-displacement curve. In order to generate the load-displacement curve as given in
Figure 1.28, follow these steps:

Click the Curves manager button in the toolbar. The Curves manager window pops
up.

Figure 1.27 Curve generation window

• In the Charts tabsheet, click New. The Curve generation window pops up (Figure
1.27).

• For the x−axis, select Node 4∗ (0.00 / 4.00) from the drop-down menu. Select the
|u| option for the Total displacements option of the Deformations.

• For the y−axis, select the Project option from the drop-down menu. Select the
ΣMstage option of the Multipliers. ΣMstage is the proportion of the specified
changes that has been applied. Hence the value will range from 0 to 1, which
means that 100% of the prescribed load has been applied and the prescribed
ultimate state has been fully reached.

PLAXIS 2D 2018 | Tutorial Manual 27



TUTORIAL MANUAL

Hint: To re-enter the Settings window (in the case of a mistake, a desired
regeneration or modification) you can double click the chart in the legend at
the right of the chart. Alternatively, you may open the Settings window by
selecting the corresponding option from the Format menu.

» The properties of the chart can be modified in the Chart tabsheet whereas
the properties curve can be modified in the corresponding tabsheet.

• Click OK to accept the input and generate the load-displacement curve. As a result
the curve of Figure 1.28 is plotted.

Figure 1.28 Load-displacement curve for the footing
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